AutoTrack v3 Software Update Information

You can get the latest software updates as well as Technical Support by visiting the P Squared Website at http://www.psquared.net/support/ or the P Squared Forum at http://forum.psquared.net/

v3.1.51

Cart Changes:
·	Myriad Users can now store much longer Web Notes (up to 32,768 characters) via Edit Cart where previously you were limited to 256 characters.

The following issues have been fixed:
·	When importing a Song or Link from the Audio Browser, the selected Category would be ignored and the Category from the Cart was always used.
·	Importing a Song or Link from the Audio Browser would only work correctly in List mode.

v3.1.49

The following issues have been fixed:
·	Fixed a problem with Exporting Category Names to Myriad.

v3.1.48

AutoTrack now reads and writes .txt versions of Notes when working with a Myriad Audiowall (instead of the legacy .RTF version). This is to provide the same behaviour as Myriad v3.

v3.1.47

Import changes for Myriad v3 Users: AutoTrack v3.1 is now able to read and write Category information from your Audiowall. By default, whenever you create a new Song Card, AutoTrack will now automatically set the Category 'dropdown' for you. However, this feature will only work correctly if you have exactly the same Song Categories set in both AutoTrack and your Myriad Audiowall. There are 2 new menu options to help you achieve this. You can either have your AutoTrack Categories 'pushed' onto your Audiowall (overwriting the existing Categories in Myriad) or you can 'Pull' the existing Myriad Categories into AutoTrack. 

If you are already using AutoTrack to manage and maintain your Category information your should use the Carts Menu option to "Export AutoTrack Category Names to the Audiowall" and then run an Audiowall Update to overwrite all the Category information on your Audiowall with the information in AutoTrack.  

Alternatively, If this is the first time you are adding Songs to your AutoTrack Database and you have already been Categorising carts on the Audiowall, you should use the Carts Menu "Import Audiowall Category Names into Autotrack" option instead.

Regardless of which option you choose to use, by default AutoTrack will NOT automatically write each Songs Category information when you save a song Card. To have this information updated on the Cart each time you modify a Song or move it a different Category (i.e. via dragging between 2 deck viewers) you need to go into Database Settings>More Settings>Song/Link Card and turn on "When saving Songs, update the Category...." option.

For more information about this powerful new feature please contact P Squared Technical Support or visit the Forums at http://forum.psquared.net/

Myriad v3 Cart Interaction:
·	When editing a Song's detail, the category information is now stored on the Cart as well as in the AutoTrack database. When creating a new Song Card using an existing Cart, the Cart's category is now used to prepopulate the Song Card.
·	There is a new option on the Audiowall Update Utility to read or write the Songs category information from/to the Carts on the Audiowall. Please note that this only applies to Songs.
·	There are 2 new menu options on the Carts menu to import and export the Song Category names to and from the Audiowall.
·	When auto-importing Carts as Songs, you can now set AutoTrack to import it into the Category specified on the Cart.
·	The Audio Browser 'Filter Search Results' window has been improved to better explain the options, it also has a new option to only show Carts that have been categories as Music on the Audiowall but that have not been added to the Database, also an option to show Carts that are in the database as Songs,but where the Category on the Cart is not set the same as in the Database.
·	There are new Cart Menu options to take you straight to the report that shows Carts that have not yet been added to the Audiowall and also the new report that shows Music that has not yet been added.
·	The Audio Browser now shows Cart Content Type and Category information.
·	The Data and Audio Locations are now shared with Myriad v3 so you don't have to set them in both applications
·	Moving and Renaming Carts also renames the Peak files and the Thumbnail files.
·	Important changes to 'Linked' audio files: The option to Link carts to audio files is no longer available as this feature has been deprecated.

General Changes:
·	If you have clicked to listen to the Cart from a Song or Link window, closing the window now ejects the Cart from the Player. Alternatively, if you use the Prev or Next buttons to 'walk' up and down a Search results window whilst audio is playing it will automatically play the freshly selected Song/Link
·	The Database Selection window has been upgraded to the Myriad v3 style window.
·	The older Myriad v2 style "Multi-Config" window has been replaced by the Myriad v3's "Multi-Profile" window.
·	If you attempt to play a piece of audio that is not in the Microsoft WAV format, then AutoTrack now uses your installed Media Player application instead.
·	The Song Category Search Depth now defaults to 50 for new Categories.

AutoTrack Pro Changes:
·	In Autotrack Pro, the Default Playout system is now Myriad v3 instead of Myriad v2.

Other Changes:
·	The CD Ripper function has been removed as it not compatible with Windows Vista or Windows 7.


v3.1.46

The following issues have been fixed:
·	Running a copyright report with a large number of results could cause AutoTrack to exit.

v3.1.45

If using the Command Line scheduling Options, the Updates information is not displayed

The Show Alternate Items list in the Schedule Viewer will now hide any items that are not allowed to schedule on the Date you viewing.

The following issues have been fixed:
·	When clicking the "Send" button to send logs to playout, the Song and Link information would be updated even if you had cleared the option to do this in Database Settings.
·	Links set with "This Link can only be scheduled to play in front of a Song..." were being scheduled before Songs that didn't have ANY Type set. This has now been corrected so these Links cannot be scheduled before such songs.
·	The 'Splash' screen now displays correct information when running on Windows 7 and Windows Server 2008R2
·	The Audio Settings "Maintain the complete Cart list (recommended)" could not be switched off

v3.1.44

The following issues have been fixed:
·	There was a browse button being displayed on the window used to edit Auto-Hooks. if you clicked this button, AutoTrack would then shut down.
·	On Windows Vista and Windows 7, reducing the size of the Database Information Browser could cause AutoTrack to exit
·	Link Types were not being shown on the Link Window when the option to use Follow Song Types instead of Categories was turned off
·	Several scheduling and unscheduling problems existed with users in non-English regional settings.

v3.1.43

The Generic Log output now support Split Cart Groups. These are shown as an audio item starting at 80001 - i.e. Cart Group 1 is shown as 80001, Group 65 is shown as 80065.

If you are using automatic scheduling, you can now specify the database name that you want AutoTrack to open on the command line using /database=<DatabaseName>

P Squared Directory Changes: Due to problems with Vista and Domain Integration, SQL Server is no longer supported for the P Squared Contacts and Users Directory and the options have been removed, so you should plan to migrate to a file based Directory as soon as possible.

The following issues have been fixed:
·	Myriad users: When saving Songs or Links or using the Mass Audiowall Update Utility to update a Myriad v3.5 Audiowall the Command, Category and Content Information could be lost, as well as causing problems if the Cart was not a WAV file. Mass moving Carts would also problems.

v3.1.42

P Squared Contacts and Users Directory Changes:
·	The Directory no longer automatically creates backups once a day. The default settings are now to prompt users once a week when they login to create a backup. Backups are now kept for 28 days instead of 7 days. This behaviour can be altered via the Backup tab on the Directory Settings window.

(PSQReference: SVN)

v3.1.41

The Generic Playout System interface has been updated to include AutoHook information if it has been entered with a database using Myriad v3 as it's Primary Playout System.

The following issues have been fixed:
·	The BSI/Simian output was only allowing 6 characters for the Audio FIlename. This is now 128 characters. Please note you will therefore need to alter your Import settings in Simian to use this log format.
·	The Nearest Play Similar Time rules were not working correctly when testing plays near the midnight boundary - i.e. a song played during the 23:00 was not always correctly clashing against a song to be played at 01:00. This did not affect the Nearest Play Protection rules.

v3.1.39

The Enco Playout System Interface has been updated to include more information as well as autodetecting if a Cut is likely to have a Fade ending, as well as noting on the description line if there is an Audio Start time.

AutoTrack no longer displays an error message when scheduling days with no clock Assigments. This was causing Automatic scheduling to pause on these days.

v3.1.38

The following issues have been fixed:
·	When entering a cart number into New Link or New Song, Autotrack would occasionally exit if the cart was empty.
·	If you ripped on a CD, the tracks would not be playable using Myriad v3.5.7
·	When exiting from AutoTrack, some users were still seeing a message saying that AutoTrack had errors and was being closed.

v3.1.37

Support for Myriad v3.5's extended Database Information has been added, as well as improved handling for Carts, so information about Commands are not removed by AutoTrack's Edit Cart which does not display this information.

The following issues have been fixed:
·	When exiting from AutoTrack, you would sometimes see a message saying that AutoTrack had errors and was being closed.

v3.1.36

The following issues have been fixed:
·	Some users who have migrated from AutoTrack 2 to AT3 Pro were having "null" errors when trying to use the Mass Changer to edit categories.
·	You could not use the Mass Change to alter the End Type of Songs.
·	The Import From Spreadsheet could not import certain Categories correctly - such as having both D1 and D2 would cause it to import both sets into D1 only
·	You could not see Song and Link Search Results if you had not set a primary playout system

v3.1.35

The following issues have been fixed:
·	AutoTrack Standard Users could not select the type of Hardware Line Action (ie. Set/Clear etc.) when editing Clocks
·	Copyright Reports that amalgamate Plays to give Play Counts (such as UK PRS Commercial) were not exporting the correct number of plays to the CSV file.

v3.1.34

The following issues have been fixed:
·	Some users were finding that the Clock Assignments grid was not showing the bottom couple of rows.

Future support for Myriad v3.5's enhanced AutoHook and Command features have been added.

v3.1.33

AutoTrack Standard users can now set the Category Pass Order. For more information about this feature, please see the help system. 

The IMRO report has been split into 2 different parts - Music and Commercial+Ident returns. These are selectable when running Copyright Reports, but also from the "Save as CSV" window.

v3.1.32

The P Squared Contact Directory in AutoTrack now supports using Multiple Profiles. 

The following issues have been fixed:
·	AutoTrack was unable to send Logs to Myriad v2 and Myriad v3 if you had a link with a large amount of text in the "Other Information" field. This information is now cropped to fit.
·	If you opened the Audio Browser and changed to list mode, you could cause AutoTrack to reducing the size of the window significantly.
·	The General Myriad Copyright Report's columns were to narrow to display the AirDate and Time correctly.
·	When using the Command Line Scheduling options introduced in v3.1.11 and revised in v3.1.29, AutoTrack would stop and wait for the user to confirm some scheduling messages if the hours being scheduled were already in the Playout System. These messages are no longer displayed in this case. However, if the Playout System cannot be accessed, then AutoTrack will still stop with an appropriate message.

v3.1.31

AutoTrack Pro now uses the P Squared Contacts and Users Directory to manage User Login. This system is shared with users using other P Squared products such as Myriad v3, Powerlog v4, Nexus v1 and Scoop Edit v3. This supercedes the old Myriad v2 based User Security system. More details about the Contacts Directory can be found on the P Squared website at www.psquared.net

As well as the basic Directory actions such as Login/Change password etc. AutoTrack logs the following user actions in the Directory History: 
·	Song/Link/Clock/Clock Assignments/Rules being Added/Edited/Deleted
·	Schedule/Unschedule
·	Send/Remove from Playout
·	Retrieve Playlogs/Reconcile playlogs
·	Settings Changed
·	Database Settings Changed.

AutoTrack is now available in a "Standard" version as well as the original Pro Version. For more details about the differences please see the "AutoTrack Pro vs AutoTrack article" on the P Squared Website at http://www.psquared.net/autotrackpro_advantages_over_autotrack.htm

AutoTrack Pro now has a Playout System interface for BSI's Simian v1 product. It allows you to browse Simians audio database as well as the obvious export of logs for Simian to import. The export format is the same as the Generic Log format, however the last field has been changed to a "+" for "segue onto next item" rather than the "X".

The Import From another Scheduler window can now import from a straight Excel Spreadsheet. Please see the included sample and documentation for more information on the format of the Excel spreadsheet.

There is a new setting under Database Settings>More Settings : "When saving songs/links, update Notes and Ending in the Primary Playout System". This controls whether when clicking to save a Song/Link, the information is updated in the playout system as well. Turning this off will allow you to maintain separate note information in AutoTrack from your playout system. It is also usefull for certain playout systems to prevent extra information stored in the system from being overwritten.

The Copyright Report "Save" button now exports in several different formats:
·	UK PRS
·	IMRO Copyright
·	Other
To access the different export formats click the Save button and then choose the format from the drop down file format selector at the bottom of the window.

The following issues have been fixed:
·	Copyright details were not being imported correctly from Carts when typing Cart numbers into Song and Link cards.

v3.1.29

The feature added in v3.1.11 that allows you to use Command line options to set AutoTrack automatically scheduling have been revised to bring them in line with Myriad v3's Log Exporter Tool (v3.0.19 and higher). The new format is /SCHEDULE /Start=<StartDateTime> /End=<EndDateTime> {/QUIT}

The date format is a modified version of the XML datetime standard.  The format is:
   <yyyy-mm-dd | nowday[<+|->x]>T<hh:mm[:ss] | nowhour[<+|->y]>

Basically you have a date on the left and a time on the right separated by a "T".

A date can either be yyyy-mm-dd (eg 2006-08-30) or a relative date such as "nowday-3".
A time can either be hh:mm:ss (eg: 14:32:55) or just hh:mm. It can also be relative by hours. e.g: "nowhour+5".

You do not have to specify both components.  You can just use the date or the time on their own.  The part you missed out defaults to nowday for dates and nowhour + 1 for times.

The optional /QUIT causes AutoTrack to exit once it has completed scheduling. Note that any message boxes will remain on screen and you cannot run AutoTrack again until you have clicked the OK button. If you are using User Security you will need to use further command line options and should contact support@psquared.net for more information.

The following issues have been fixed:

·	The Cart number is now included in the filenames of Transport Files

v3.1.28

The following issues have been fixed:

·	Reducing the size of the Schedule Viewer with the Alternate Items list showing would cause AutoTrack to Exit
·	Exporting Audio as Wav or Transport files would not write the audio to the selected folder.
·	When turning off the "Use lengths from Playout System instead of AutoTrack's" option in AutoTrack Settings, it was reporting all hours as being zero length.

v3.1.27

The following issues have been fixed:

·	AutoTrack would exit when opening song or link cards that use Myriad v3 carts that had the end set to Sustain or Slowfade.  As a caution, you should avoid editing the cart details of such carts using Autotrack as AutoTrack does not have the Sustain and Slow Fade ending options on it's edit cart windows.

v3.1.26

IMPORTANT: There is a new option on the Database Settings window - "After Scheduling, Send updated Song and Link Information". This determines whether AutoTrack should automatically update the Song and Link Information stored in compatible Playout Systems - i.e. Myriad v2 and v3 - after each schedule. Previously this was done automatically every time, but for users that have a large database with frequent updates it can become very time consuming. If you have a small database then this is not a problem and we recommend turning this option on. If you have a large database, keep this option turned off, and instead use the Update Info button on the Playout Systems tab to update the info after you have carried out any significant changes to your database.

The following issues have been fixed:

·	Link notes were not being sent correctly to Myriad v3 playout systems. 


v3.1.25

The Copyright Report Generator has now been updated to work with Myriad v3. Previously you could not select the correct Computer to read Play logs from. The "End Terminal" drop down option has also been removed, so you now select the exact location you want to retrieve logs from.

There is a new option on the Database Settings window that allows you to enter the estimated duration of Advert Breaks. This calculation is then used when preparing Clocks and during scheduling to calculate an Hours estimated duration.

The Song Year is now displayed on the Song Search Results.

When you copy a selection of Songs or Links to another database, you are now prompted to confirm before it starts.

The Database Settings window has been slightly re-arranged to a more logical layout.

The following issues have been fixed:

·	Sorting Song or Link Search Results by Cart Number (AKA Hard Disk Reference) would sort incorrectly on numeric based playout systems.
·	The clear option on the right click menu on Clock Items was not working
·	The Song and Link Notes weren't being fully sent to  Myriad Playout systems - only the first 255 characters were making it through.

v3.1.24

AutoTrack can now retrieve Play Logs and Reconciliation information from computers running Myriad v3. It also uses Myriad v3's 'On-Air' information to automatically determine which computer's play logs to use to import from. Please note that this feature should NOT be used if you are running more than 1 radio station from the same Data Location, as more than 1 computer will legitimately be 'On-Air' at the same time.

There is a new button on the Clocks Tab - the New Assignment button opens a new blank Clock Assignment grid.

The List Clock Assignments Grid icon has been changed to be easier to understand.

v3.1.23

There is a new Audio Settings option on the Settings Menu. This displays a window that allows you to configure how many audio players you have, as well as other audio settings such as which Audio Editor to use.

AutoTrack Pro Users: There is a new option on the Database Settings window that allows you choose whether the Link Scheduled to play before a Song rule uses Song Types or Song Categories. This defaults to Song Types to give the same usability as before.

Support for retrieving Play Logs from Myriad v3 has been temporarily suspended due to changes in the way Myriad v3 Stores its cart play information. This support will be reinstated in a future version.

There is a new button on the Scheduling Rules tab on the Station Rules window that resets the selected Categories rules back to the defaults.

The following issues have been fixed:

·	Importing Play logs from Myriad v2 Playout systems could cause an 'Overflow' error if they contained large Scheduler Reference fields (usually from other music or advert scheduling systems)
·	The Copyright report was ignoring the Profile selected in the window and only displaying one set of columns.
·	AutoTrack would sometimes exit when scheduling songs that had a start characteristic set but not an end
·	You couldn't do an 'Advanced' search for songs that had a certain characteristic as a start and 'no' characteristic as the end
·	The Generic Playout System output format was not setting the Item Ending Type (Stop/Go) for Advert Breaks
·	The Myriad Audiowall Update utility was not correctly setting the flags to indicate that a cart also had notes attached

v3.1.22

Myriad v3 Support: This is the first version of AutoTrack that supports Myriad v3. This is based on the first versions of Myriad v3 that will be released and AutoTrack will be updated as Myriad v3 evolves. To send to a Myriad v3 Station Database's Log, add in a Myriad v3 Playout System. 

Myriad v3 users can now add 'Auto-Hook' items to their Clocks. These are set up in exactly the same way as they are added to the Log in Myriad.

The following issues have been fixed:

·	Fixed a problem with the Couldn't Be Scheduled report where it would show Links in the results for Songs
·	When you right clicked on the 'Select' button for a Myriad v2.6 Q-NXT Station Database, it was forgetting the path that you had previously selected. Left click ALWAYS shows you a selection list from the normal default data location
·	Attempting to use the Link Reorganiser could cause an Invalid Use of Null error and AutoTrack would exit
·	The Link Deck Reorganiser did not move the items to the new deck previously, but checking them in the Link Cards showed that they had been updated. (Previously the workaround was to rebuild the Link Decks)
·	You couldn't enter hardware end test information for Absolute Times

v3.1.21

The following issues have been fixed:

·	Searching by Characteristic would not return the correct results in both Songs and Links
·	Very long Category/Type or Gender names would cause AutoTrack to exit when sending information to a Myriad v2.6 Q-NXT Database
·	Exporting a transport file or a wav file for an item that had a question mark or an asterisk in the title would cause AutoTrack to exit.


v3.1.19

This Update Information is displayed when you start AutoTrack for the first time.

AutoTrack has a new Icon to match the new Logo and Splash screens

The new Import Utility can now import from Natural Music Browser text files.

You can now search the Song and Link Notes and WebNotes.

The Audio Browser now searches the DAB and Web notes as well as the regular notes - see issue "fixed" below as well.

There is a new button on the Audio Browser that goes through the selected audio items and searches the database for any that have the HDReference (Cartnumber for Myriad users) set to the same as the Title of that audio item - i.e. a user might be migrating to Myriad and might have imported "A1234.wav" into cart 3001 on their new Myriad Audiowall - it is now titled "A1234". This option will search the songs and links looking for any items that have the HDReference set to "A1234" and then update the item to show that it is now in Cart 3001. 

When printing the Scheduled Log, it now only prints one hour per page to make it easier to read.

There is now a 'Release License' option on the License wizard which allows you to release the license so you can use it on another computer - this only works a limited number of times however, and you must be connected to the internet before you can use this feature.

There is a new button on the Audiowall Browser that allows you to decide if AutoTrack should show the empty audio items in between items that have a caption and/or audio. This is very usefull for mass moves etc. so you can only "move" items that actually exist, rather than trying to move items that are empty.

The following issues have been fixed:

·	If you tried to "Copy" a clock in the List Clocks window and entered more than 8 characters for the Reference it wouldn't copy. This is becuase the limit for the Reference is 8 characters. You are now limited to entering only 8 characters.
·	The icon on the Remove From Playout tab was incorrectly set to the old v2 icon when you first go into the window.
·	The option to search cart notes in the Audio Browser was not correctly implemented - i.e. it didn't.
·	When you first licensed AutoTrack, some users had to License twice becuase of a message regarding the license not being valid for the computer.

v3.1.18

AutoTrack has a new Logo and Splash screen

By default, the "Keep a list of every Item that is tried for each position in the log" (Database Settings, More Settings tab, under Scheduling) is now turned on. If you have previously decided to not use this feature, you will need to go into the Database Settings window and turn it back off.

The following issues have been fixed:

·	If you tried to load an hour restriction hotlist into a Song or Link Card but hadn't saved any yet, then autotrack would exit.
·	Applying an Hour Restriction to a song or link would not enable the OK and Apply buttons.
·	There was a typo at the top of the Link Types and Song Types tabs in Show Rules
·	Running an 'Items not Scheduling' report for link categories would cause AutoTrack to exit.
·	Statistics were not being calculated correctly for Characteristics
·	The Jump To box on the Audiowall Browser in Grid and Single Line mode did not jump you to the cart you entered.


v3.1.17

There is a new button on the Deck Viewer that allows you to shuffle only the songs or links in the visible category, rather than the whole database.

The "Couldn't Be Scheduled" report now shows a title column as well as the Item Number column

The columns in the Clock window are now re-sizeable. You should however that these new sizes are not stored, and then changing the view or closing and reopening the window will cause them to re-set to the defaults.

The following issues have been fixed:

·	There was a typo on the Search for Songs window on the Other and Date Range tabs where it had the word "Links" rather than "Songs".
·	If you selected more than 1 day when running the "Couldn't be Scheduled" report, AutoTrack would occasionally exit.
·	When Searching by title using the Audiowall Browser in Grid or Single Row modes, the playout system was only searched from the Reference in the JumpTo box onwards rather than the whole Audiowall. This is different from the way it works in List mode so has been changed to search from the start of the Audiowall instead. If you need to search a specific range, you should use the List mode instead and enter a start and end range.
·	The "Not Scheduled Count" column in the "Items not Scheduling" report was sorting incorrectly when clicked.
·	The refresh button on the Scheduled Log Viewer did not refresh the display


v3.1.16

It should be noted that the Generic Log Output format does not support 'Wait for hardware' information for clock entries.

The List Clocks, Clock Assignments, List Station and List Show Rules have had some work done to make the text easier to read when resizing the window.

You can now add up to 250 characters in each of the Copyright text boxes on Songs and Links, and they have been replaced with Drop down boxes that allow you to quickly fill the fiels with information that has already been entered for other items.

There are new date options available when searching songs and links - these have also resulted in a new cleaner look to the Date tab on the Search for Song/Link windows. The search results also now display the corresponding date information.

The Last Edited/Date Added displays on the songs and links windows are now easier to read

The following issues have been fixed:

·	The Generic Log Output was sending the time for Absolute Times in HH:MM:SS format - it should have been MM:SS as the hour information is not used by the Myriad Log Importer
·	If you had a very long Song Title or Artist Name on one or more songs then "Updating the Song Library Information" to a Myriad Q-NXT database would cause AutoTrack to exit.
·	Clicking the middle grid row on the properties of a Station Rule that had 3 rows (i.e. Hour Protection) caused AutoTrack to exit.

v3.1.15

A new set of "Nearest Play" rules are now available that allows you to test items when they are scheduled against the last/next time that they are due to play. The two new rules are "Nearest Play Similar Time" and "Nearest Play Hour Protection". They are available for Songs, Song Titles, Artists, Artist Groups and Links. Examples:

·	Song Nearest Play Similar Time  - works the same way as the other Similar time rules, but the slot being tested is compared against the last time the item was scheduled regardless of how long ago that was. An example would be a song that was last scheduled 3 months before at 2am. If the song is being tested for scheduling for today at 3 am and the "Number of Hours either side" was set to 2 or more then the scheduler would reject the song becuase the previous play (at 2am) is within 2 hours of the tested slot (3am) - even though it was some time ago.
·	Song Nearest Play Hour Protection - works the same way as the other protection rules, but again, the slot is compared against the last time the item was scheduled regardless of how long ago that was. An example would be a song that was last scheduled 3 months before at 2am. If the song is being tested for scheduling for today at 5pm and these two hours are "protected" from each other then the scheduler would reject the song - again, even though it was some time ago.

AutoTrack now has a new Import Utility that makes it a lot easier to import Songs (and also introduces support for importing Links) from other schedulers. This uses a pair of matching report formats that "layup" the information in a certain way. Full details of these formats are available on request, and we have some configuration files for other schedulers that will help you produce files in the correct format. The new Import Utility is also scalable so we can add more import formats in future. However, this does mean that we have dropped support for importing from Excel Spreadsheets - these required a considerable workload to setup and the new text based formats are much easier to use.

The name of the window used to browser audio has now been standardised to "Audio Browser" - in previous editions it was referred to as the Audiowall, the Audio Browser, and the Cart Report in different sections. The documentation will also be updated to reflect this shortly.

There is a new option in the Audio Browser that Exports the highlighted audio to WAV files in a directory of your choice. This is underneath the Export Transport Files (previously called "Create Transport Files") option on the drop down list on the Edit Button.

"Scheduling Reports" are now called just "Reports" and has a new look that allows us to more easily add more reports in future. The seperate options on the Reports and Statistics menu have therefore been removed. All the reports are of course still available from the Reports window. The Report Results window has also recieved a few updates.

There is a new Report available - "Songs/Links not scheduling". This will display a list of all songs or links that have been failed to be scheduled 1 or more times in their current rotation through their Deck. Each time an item is tested a counter is incremented that is only cleared when the item is successfully scheduled and 'thrown' down the deck. This report shows those items that have not been thrown recently. It is normal that this report should show some items with a low number (that is how the rules work after all!) but any with a comparatively high number indicate that the item is not being scheduled correctly and that you should look further into why.

Another new report allows you to enter the ID of a Song or Link and then view the list of each time it has failed to be scheduled when tested. This is very usefull for seeing the reasons why a song or link has not been scheduling as it will display the reason for each and every time it was tested. Due to internal changes to enable this feature, this means that any Tested Item Logs from previous versions of AutoTrack cannot be seen in the Schedule Viewer in this version. 

A new soft grey grid is displayed across various windows including search results and the Schedule Log Viewer. If you want to turn this off then you can do this from the Settings Menu under AutoTrack Program Settings.

The Schedule Log Viewer has been slightly overhauled to bring it more into line with the other windows in AutoTrack. It also has a new Print button that makes it easier to only print some hours from a days log rather than the entire day.

You can now easily import Backup files from another location into the Backups list. In Database Settings on the Backups tab click the new button with a folder and a green arrow on and you will be prompted for which file to import. There is also a new option on the Tools menu that takes you directly to the Backup pane in the Settings window.

The Song/Link search results now shows an icon next to the entry in the list if it has a HD Reference. The icon is a speaker if the audio is found, or a speaker with a cross though it if the audio is missing. Clicking the speaker icon will play the item for compatible playout systems.

You can now optionally display the Item "Type" in the Deck viewer - this setting in the Database Settings window.

You can now search Song and Link Copyright details for partial strings as well as whole strings - e.g. previously you could only search 'Performer' for "Michael Jackson", you can now search just for "Jackson" or "Michael" etc.

When editing the Song Category Follow Rules in Station Rules, it is now much cleared which category you are editing in the lower area.

There is a new button on the Station Rules window on the Scheduling Rules tab that copies the rules/guides set for the currently visible category to ALL the other categories. This removes the destination categorys' rules/guides completely and replaces them with them with duplicates of the rules/guides for the visible category.

The Clock Assignment Grid Window is now wider and can also be sized to improve the display.

The display whilst scheduling has been improved to show the time and date that is currently being scheduled.

The following issues have been fixed:

·	Some databases have "Null" values in some of the information in the list of Songs stored in the database that caused the AutoTrack to close when trying to view the Alternate Items list in the Schedule Viewer. This "Null" information is now being handled correctly.
·	If you had a VERY long scheduling History, this could cause the automatic history remove process problems so it wouldn't be able to remove all of the histories. This process now also has improved error reporting.
·	A "Pause" at the end of a Pad run would cause AutoTrack to exit
·	Songs rejected due to Artist Group rules that were listed in the Tested Items area of the Schedule Viewer were displaying the wrong Artist Group name in some circumstances.
·	The "Display Compressed/Linear Audio" filter options for the Audio Browser were reversed so it was displaying Hard Disk items that were compressed when you had selected Linear and vice-versa.
·	AutoTrack now warns you if you try to save a Show Format and have not filled in a Weight, Min and Max for a Song Category. All 3 must be entered before AutoTrack can use that it when choosing which categories to place into Clocks during scheduling.
·	The "Range" feature in the Audio Browser that was removed in v3.1.11 has been added back in to make it easier to limit the range of carts that are being scanned when running complex filters. It is only used however when using the Browser in the List mode.
·	A very minor problem where on some complex Category setups, clicking the Category or Type fields on a Song or Link entry in a clock wouldn't preselect the currently selected category in the drop down list that is then displayed.
·	Previously when AutoTrack asked Windows(tm) to display a new window, Windows would display the new window off the side or bottom of the display area meaning you had to move it back in to see all of it. New code has been added to most of the windows in AT to counteract this so windows should display in the main area the moment they are first opened.
·	When you clicked Schedule for the second time in a row, the number of Unscheduled Songs and Links from the previous schedule runs was still displayed. 
·	When you opened a Schedule Log viewer and then clicked Print on the File menu you would only get a couple of the log entries printed on the printout.


v3.1.14

AutoTrack now supports exporting Logs to Dalet 5.x Systems.

When using the Mass-changer to assign Songs or Links to Collections you are now told that you must also change the Category at the same time - this is to ensure that all the items you are attempting to add to the Collection are in the same Category as the Collection.

The names that Playout Systems use for their audio (i.e. "Cart", "Cut" etc.) is now displayed on the Song and Link Cards next to the box where you enter the details of that audio.

The following issues have been fixed:

·	You could previously only edit up to 10 carts before being erroneously told that you had to close some edit windows before you could continue even if you were religiously closing edit windows once you had finished with them
·	If the scheduling window was already open when using the Schedule History viewer, clicking the buttons at the top of the history window didn't bring the Scheduling window to the front
·	If you clicked the Song/Link/Artist history buttons on the main window and there were no entries for that type of history then the button would stay raised and "red"
·	Double clicking an hour in the Scheduling Reports results window would not "jump" to that hour if the Log was already open in a log viewer
·	When saving a new song or link and you manually entered a Song/Link number you would be warned that changing the number creates duplicates - this message is now only displayed when editing an existing song/link.

v3.1.12

AutoTrack now supports exporting Logs to Dalet 5.x Systems.

When using the Mass-changer to assign Songs or Links to Collections you are now told that you must also change the Category at the same time - this is to ensure that all the items you are attempting to add to the Collection are in the same Category as the Collection.

The following issues have been fixed:

·	When Exporting a Cart to a Transport file from the Cart Report you would previously see a "Debug" message - this has been removed.

v3.1.11

A New rule is available that allows you to say that a song in a given clock position must come from a certain year. The entry in the Clock can also be set to "Ask" you - in which case when you come to schedule that hour you will be prompted for what year items in the hour that are set to "Ask" must come from - ideal for Guess the Year features. To use this rule, you have to add it to the Categories that you want to apply it to in Station Rules.

When opening a Song or Link card from the Song/Link search results window the Song/Link card now displays "Previous" and "Next" buttons in the bottom left corner. These allow you to move up and down the results list from within a single window, rather than having to close the window and then click on the next entry to open a new window.

The Song and Link Search windows have been improved to give more search options including Copyright and Style searching.

There are new "Copy" buttons on the Copyright Tab of Songs and Links to help with entering Copyright Details.

Myriad and Enco users are now informed when "Sending to Playout" if a cart or cut is scheduled to play, but does not exist.

The Scheduling progress area has been overhauled and now displays the number of songs and links that have not successfully scheduled. This information is also displayed after scheduling has completed.

By default AutoTrack now doesn't read or write copyright information to compatible Playout Systems when opening or saving Song and Link Cards. You can turn this feature on from the Database Settings Window. Before you do though you should ensure that you are happy with the information stored in either AutoTrack or your  playout system and then perform a mass export or import as appropriate to ensure that the information is identical in both places. If you are using multiple databases you should consult with P Squared before turning this feature on as it could result in accidental overwriting of some of the Copyright Details.

When searching an Audiowall, Displaying Song or Link Search Results and looking for alternate items for entries in the schedule an animation is now displayed to show the process's progress.

The Song/Link Play Counts window now shows the name of the category that each item is in.

New command line options have been added to make AutoTrack automatically schedule up to a specified date and time when it starts. For instance, specifying /SCHEDULETO="1 August 2004 15:59" /QUIT will cause AutoTrack to schedule up to 4pm on the 1st of August. If your Database Settings specify that logs should be sent to playout after being scheduled then this will also happen. The optional /QUIT causes AutoTrack to exit once it has completed scheduling. Note that any message boxes will remain on screen and you cannot run AutoTrack again until you have clicked the OK button. If you are using User Security you will need to use further command line options and should contact support@psquared.net for more information.

There is a new AutoTrack Program Settings option on the Settings Menu that brings up a window that contains the settings that are for AutoTrack as a whole, rather than per database.

A new option on the AutoTrack Program Settings window gives you the ability to control whether AutoTrack should use the timing information that it has stored in it's Song and Link Cards, or whether it should read the information from the Playout System when running Scheduling Reports (such as underrunning times) and when displaying the Schedule Viewer.

The Cart Number/Hard Disk Reference is now printed out when you printout a Schedule from the Schedule Viewer.

When AutoTrack is calculating the length of Scheduled hours, it no longer uses the average length of the Categories for unscheduled items. This is to give a better indication of the length of an hour as it will play - i.e. unscheduled items now have a length of zero.

The Underruning hour report has been renamed to the Schedule Warnings report to reflect new features - it now displays the number of songs and links that remain unscheduled in each hour, as well as those that have been successfully scheduled, but have no hard disk items associated with them (missing audio). If the setting to use Timing information from the Playout Systems is turned on then the missing audio report also shows items that have hard disk items, but have no audio in those items.

The "Copy Information to Another Database" tool can now copy Clocks, Rules and Clock Assignments to another database as well as Songs/Links etc. Note - When copying just clocks (i.e. no Song or Link information) you should copy your Song and Link Categories, Types and Styles to the destination database as well otherwise the Clocks and Rules will not display the informaiton correctly. This is because these display settings for each Category/Type etc. and without correctly set information they will not display accurately.

The Import Audio Wizard now supports Myriad Transport Files. This support will be improved to give better visual indication in a future release.

When deleting songs and links from the Song/Link search results window, there is now a cancel button when you are asked if you want to the delete the audio associated with the song/link. Clicking this will stop any  further deletes occuring - but you should note that those that you have already Ok'd being deleted cannot be recovered.

If a database is encountered that is corrupted,  then a backup copy of the original file is  taken (it has the same filename but is followed by a number and now has the extension .BAK) and  then it is automatically repaired.

The "Range" feature in the Audiowall Browser has been removed for ease of use, and the Audiowall Browser windows is now displayed and updated far quicker.

When viewing Myriad Cart Play Logs a new column is now shown that gives the actual duration of the cart so you can easily compare it against the Played duration. Any discrepancies are shown in red.

The following issues have been fixed:

·	Importing Songs from an Exported Report from other playout systems would give an "overflow" error if they were using some Sound Codes that hadn't already been setup.
·	Songs and Links that have been given a Media Type were not re-displaying this media type when you re-opened their card.
·	Certain issues with older databases using Media and Item Numbers meant opening Song and Link Cards could cause AutoTrack to exit. This has been resolved.
·	The Alternate Items list was not showing "nearest plays" of items that are scheduled within the same hour correctly.
·	Using the mass import to mass import items from the audio browser would  also attempt to import empty items. It will now only import items that have audio.
·	In the advanced display mode on the Clock window you couldn't see the description field even if you had ticked to say you wanted to see it - this has been corrected.
·	The pie charts in Show Rules were displaying the colours of the Song and Link Categories incorrectly if you have gap Categories/types. This has been corrected.
·	Removed a message box that erroneously displays "field size too small" when copying databases with long descriptions
·	Changing the display mode (ie grid/list/singlerow) in the Audiwall Browser while it was already updating the display would cause the Loading Items panel to remain visible until you changed mode again.
·	Saving Hour Restriction Grids in Links only saved the part of the grid information.
·	Fixed a problem with having more than 1 Audiowall Browser open simultaneously.
·	When adding songs with 2 Artists the copyright details would have the second artist listed twice if you "read" the titles from a Hard Disk Item.
·	Fixed a problem with importing Play Logs from the Schedule viewer where it would attempt to import play logs from the first hour of the next day as well

v3.1.4

A new Song and Link Re-Organiser is now available on the corresponding menus - this tool allows you to quickly reorganise large numbers of songs or links into new categories and types.

The Audiowall Report window has been improved to give more descriptions when updating the window and the user has given conflicting information.

The Change Password Menu option has been moved from the Users menu to the Tools menu. This is becuase the Users menu is not visible to users that do not have permissions to edit Users Details, but users still need to be able to change their password.

The Database Copier can now copy Characteristics information to another AutoTrack Database. This option is unde the Other Information section.

Collections Drop down lists are now sorted Alphabetically for ease of use.

The following issues have been fixed:

·	After using the "Send to Database" feature on the Song/Link Search Results AutoTrack could not fully access Song or Link cards in some situations.
·	Fixed a problem with opening Song and Link Cards on databases where all the Category Names have been removed.
·	Fixed a problem with songs with deleted types showing as being in a deleted category on the Search Results window
·	The Alternate Items list was not being displayed for Unscheduled Items where the Item Type was not being forced.
·	The Underrunning Hour Report was basing it's findings on overall Audio Lengths, not Extros causing slight discrepancies in the report vs the Scheduled Log

v3.1.3

When using the Song Card, there is a new "internet" button in the bottom left hand corner that searchs a web database for the information about the Song or Artist. This is very usefull for looking up the year a song was released. Please note that you must have an internet connection to use this feature, and the information is NOT provided by P Squared. Future versions of AutoTrack will allow you to configure which server you use to recieve this information.

There are two new options on the Update Audiowall utility. These allow you to say whether the information should overwrite all existing information, or just to fill in the blanks, leaving the other information untouched.

A new option in Database Settings allows you to have AutoTrack pre-set the Year on new Songs to the current Year. This is on by default.

New options in Database Settings allow you to control whether Category and Type information is updated when re-copying (i.e. updating) information in another database when using the "Copy AutoTrack Database Information" window or the "Send to Database" button on the Search Results windows. These are OFF by default, so changes to the category and type information in the destination are preserved when the other information is updated.

Changes to the way Songs and Links are copied between databases have resulted in significant speed increases.

You can now search for Songs that have not had a Year set. You can also Search for songs by Copright Details, as well as bringing up a list of songs that haven't got copyright information entered.

Warning messages have been added to the Edit Cart and Song and Link Copyright tabs explaining that copyright information should always be added to the Song and Link Cards rather than the Cart Details. This is because AutoTrack information overrides that stored on the cart itself.

Myriad users can now specify which cart description line is used to fill in the Other Information on Link Cards.

The following issues have been fixed:

·	The Audiowall Report/Browser would not previously show the titles for carts where the information was interpreted as a year - for instance 1999 by Prince was did  have a title displayed, just Description line 2 was Prince
·	The Database setting to Clear the Song/Link card after saving a new item was not working correctly on Link Cards and therefore not clearing the display.
·	AutoTrack would exit when Myriad Users that have spaces in the Cart Directories ran a Linear/Compressed filter on the Audiowall Browser.
·	Double clicking on a new rule in the "Tree" on the right hand side of the Rules Tab on Station Rules would cause an error message if you were configuring Rules for a Link - configuring Rules for Songs was not affected.

v3.1.2

We have added a "Refresh" button to the top toolbar in the Audiowall viewer. This duplicates the function of the Search button next to the "find" drop down list on the second toolbar.

Fixed a problem with the Song Search results when certain characteristics have been implemented. A related problem with Song Styles has also been fixed in the Mass Changer

v3.1.1

Please make sure you read the full description for v3.1.0 as well this list of extra changes.

Added support for Radiomation.

The following issues have been fixed:

·	Previously you could not mass change the Alternate Locations field of Songs and Links. This has now been corrected.

v3.1.0

WARNING: This update contains several changes to the way that AutoTrack interacts with Playout Systems such as Myriad etc. You must therefore reset some of the Playout Settings on the Database Settings window before scheduling, to allow AutoTrack to communicate with your Playout Systems. If you have any queries, please contact P Squared immediately.

The settings for AutoTrack are now stored in the Registry rather than in the old AutoTrck.ini file. This means that some settings may have to be re-entered (such as whether users have to login, and whether to open the last database opened at startup). It may also therefore ask you which database to open when it first starts. These settings are now now longer "sub"menu items on the the Settings Menu. Instead they have moved to a new AutoTrack Settings Window. This can be accessed from the Settings Menu. In case of query, please contact P Squared.

Please note that although Media Type information can be selected in the Show Rules screen, it is presently not used to control scheduling. This feature will be added in a future release.

Other Update Information:

Each Database must now have a Unique  Database 'Enabler Code' to allow it to run. These can be obtained from P Squared Licensing. The code is entered in the Database Settings window. Additional changes relating to "Secondary" License codes (for using AutoTrack on Laptop computers) have also been made.

Reconciliation has been implemented. This can be accessed from the Schedule History Window. Although Reconciling logs is not essential, you must reconcile logs to use the Copyright Report function. Depending on your Playout System, you may need to set certain options on the Playout System's settings window. For more information on this feature, please see the AutoTrack documentation. You can do Reconciliation (and importing of Play Logs) from either the Schedule History window, or from the Schedule Viewer.

There is now a new tab on the Database Settings window entitled "Backups". From this window you can create and maintain a backup library for each database. These backups are stored in the same location as your AutoTrack Database, and a "copy" button allows you to copy the backups to an alternate location - such as a CD rom drive or your local hard disk. A restore button allows you to "rollback" your database to an earlier time - for instance you might take a backup before doing a large number of changes. That way if you decide you want to to go back to the way things were, you simply restore the appropriate backup. If you can't open a database, and need to restore from a backup, there is a new option on the File menu under "Import/Upgrade/Restore" that allows you to import from a Database File. For more information please contact P Squared.

In AutoTrack, you can now define a "Primary Playout System". AutoTrack uses this whenever it needs to see what logs have already been sent to Playout Systems, and also allows AutoTrack to access the Audio inventory (for instance the Audiowall in Myriad) if the Playout System allows. At present, Myriad is the only system that has specific support in AutoTrack for reading the audio inventory. As part of this change, almost every part of the system that interacts with Audio files (such as Myriad Carts) has been converted. The new system is scalable, and P Squared is working directly with other manufacturers to include such built-in support for other systems.

Extensive Help files have now been added. These can be accessed from the Help menu, or by pressing the F1 key for Context Sensitive Help (specific to the area you are looking at).

AutoTrack now automatically detects the presence of compatible Playout Systems' User Security and configures itself to use these. If no compatible systems are found, then AutoTrack uses it's own internal User Management.

The Cart Browser has been replaced with a new Audiowall window that allows you to see the list of audio stored in compatible Playout Systems, in 3 different modes (selectable by buttons on the Window's toolbar) - these are List - same as the old General Cart Report - Grid (similar to the Myriad Audiowall, but with a new look) and Single Row - similar to the old Cart Browser). Therefore the General Cart Report has been removed. All the options to narrow down the list of carts shown (such as must be in the database in a certain category, and must have an extro etc.) are available from the Toolbar at the top. The Find Cart window has also been removed as this is now achieved with a text entry box on the toolbar. Buttons adjacent to the box allow you to search the Cart Notes and Copyright Information. Depending on Playout System Compatibility you get different buttons at the top regarding Edit, Import and Create New audio options - so you only see options that are valid for your Playout System. This is a far more powerful feature than the old Cart Report and the old Cart Browser and if you have any questions, please contact P Squared Support or your Account Manager.

The Browse Buttons throughout AutoTrack now bring up a cut down version of the above discussed Audiowall window.

CD Ripping has now been built into AutoTrack and can be accessed from the new Audiowall window in Myriad mode. This includes CDDB or FreeDB functions to automatically download track titles from the Internet. Settings can be configured from within this screen, and it shares it configuration with Myriad. This is an initial implementation and will be improved in a forthcoming release to include new features such as the ability to edit details prior to ripping in the tracks.

The "Only Allow Hard Disk Items" has been moved to the "More Settings" tab in General Settings.

The Internal Reference number for each scheduled item is now passed to compatible playout systems. This is used in the Reconciliation features to track and adjust the histories of items that were played versus what should have been played.

Myriad Users can change the way that Cart Lines are interpreted into Songs and Links when using Carts stored in the Audiowall. To do this, go into Database Settings and then on the Playout Systems and double click on the entry you have for your Myriad Playout System. Then go onto the Audio Settings tab, and click Advanced Settings. From the window that then pops up you can change the "routings" for how information is read from the Audiowall into Songs and Links. Please note that this Advanced Audio Settings window will change over coming versions, but the functionality will always be there - just not nescessarily where you last looked.

The "Copy To Week" button on the Clock Assignments grid now only copies the selected hour(s) to the specified grid. To copy the entire week, switch out of Detailed Day View and then click the top left box in the grid. This will select the entire week for you. Then click the copy button as usual.

You can now right click on items in List Clocks, List Clock Assignments, List Show Rules, List Station Rules to be presented with a menu that allows you to edit, copy, delete and (where applicable) Set as Default. These same screens all now have a "Copy" button on the toolbar that allows you to quickly duplicate the item. They also now have a progress bar at the bottom to show the progress of Mass Deletes etc.

A new button on the Song Search Results and Link Search Results window allows you to export the list of all the selected items to a Comma Separated Variable (CSV) file. This file can be used for many things - for instance importing into Excel to get custom printouts or run specialist reports.

There is a new button on Artist and Song Title management on the Unused items tab that allows you to quickly remove all unused items in one go.

Improved the descriptions on the Rule/Guide Properties window (accessed by double clicking on any Rule or Guide inside the Station Rules window)

The Create P² Support File facility has been given a new Upload Engine that allows easy expansion in future. It also has support for the new P Squared Support Management System so you can enter a P Squared Support ID number and your email address before sending the support file. 

When you first create a Database you are now prompted to 'connect' it to a Playout System. At present AutoTrack will only automatically detect Myriad v2.6 Systems.

When using the "Choose Database Window" to select your AutoTrack Database, the "Details" view mode now includes a column to show you when the database was last successfully opened.

Copying databases is now much quicker (and the new database is called "Copy of..." instead of asking first) - and when deleting databases, the Database directory is now removed as well.

You can now drag from an item from any Category into a Collection and AutoTrack will ask you if you want to have it automatically change the category the item is in to match the category of the Collection. This is because you cannot mismatch categories - previously AutoTrack would just tell you that this could not be done.

The second column on the Deck Viewer now shows "Artists" for Songs, and "Info" for Links

Simplified the differences between the different looks to the Song and Link cards depending on whether you are in Myriad Compatibility mode or not, and have Hard Disk items only turned on.

Added a button to Song and Link cards to re-read the titles from the carts in Myriad mode.

Added a pair of option buttons adjacent to Media Types on the Show Rules window that help explain how to use the Media Types. Because of changes to the way Media Selections are stored in Show Rules, AutoTrack deliberately erases Media Selections on Show Rules created using older versions of AutoTrack. You will need to go into Show Rules to re-select the media types to use.

Added a pair of option buttons adjacent to Song Styles on the Song Card, and on the Show Rules window that help explain when Styles are used.

Added a pair of option buttons adjacent to the link/song follow information on the Link Card to help explain how this option works.

Added support for MediaTouch's Category field. This information is read from the Alternate Locations field on the Song Cards.

The speed of scheduling has been improved even further by changes to the way AutoTrack "Throws" items that couldn't be scheduled.

The following issues have been fixed:

·	Couldn't "Remove" from playout systems without un-scheduling first.
·	Unscheduled Links were being sent to Myriad as empty Text Items.
·	Switching out of Detailed Day View in the Clock Assignments window if you were looking at "Tuesday" or later caused AutoTrack to exit.
·	The Remove Artist from Artist Group button on the AT Information Browser did not work.
·	Fixed a problem with the Import from Spreadsheet option causing an "Item Not found" error.
·	Entering a large number into either the Song or Link Shuffle deck windows caused AutoTrack to exit
·	After adding your first Collection, it was not displayed in the list of available collections until you reentered the window.

v3.0.6

You can now Drag a Collection from one Deck Viewer to another to change the Category that the Collection and the items within it are in.

Improved the Mass Song and Link changers to only allow you to assign an item to Collection if you are also updating the Category - this ensures that you cannot attempt to Assign an Item in one Category to a Collection in another.

The Copyright Report has been overhauled.

New look to the Clock Editor - many many new features and abilities including a a new tree display on the left that allows you drag 'n' drop items from a selection straight into the Clock. You can also now say that a given item (i.e. a specific song entry) must be one of a set of Genders, Characteritics or Styles. This is very usefull to force "Hour Opener" styles to be the first song in the hour. You can also display the Clock in three different modes - one of which (Advanced) you can configure which columns are displayed. This makes it easy to hide the columns you don't use often.

You can now have Multiple Clock Assignment Grids - these allow you to have different Assignments for a given range of days - ideal for planning in advance for competition weeks etc. Each Assignment Grid can also now have up to 8 "Weeks" - these are then cycled through in turn to give an alternating grid.

A new report is available on the Reports menu which allows you to see a summary of which clock assignment grid will be used for each day/hour. You can also bring up this report from the Clock Assignments List, and from each Clock Assignment window - the later is ideal for checking which way round several weeks in a date restricted Grid will be used.

The Category Statistics reports can now generate a report that shows Gender, Characteristic or Media breakdowns as well as just Types.

A new option in Settings allows you to display the Gender and Characteristic information on the Song and Link search results windows.

When searching Songs or Links, you can now say you only want to see items that DON'T have a Gender or certain Characteristic set - ideal for getting a list of items that you still need to edit when going through adding additional information to items, prior to tightening up scheduling.

Fixed a problem opening the Deck viewer on some upgraded databases.

Fixed a problem with editing a Song Title, or Artist Name to change the case (upper or lower) of a character not being saved.

Fixed a problem with Scheduling Links attempting to use some Song Rules.

Fixed a graphical problem with modifying Link Collections in some circumstances.

Fixed a problem with Deleting Restriction Hotlists.

v3.0.1

Cleared up confusion over the Artist and Song Minimum separation times on the settings window. In AutoTrack v3 these times are only used when displaying Alternate items in the Log Viewer. The separation times used when scheduling are determined in the Category Rules in the Station Rules window.

Fixed a problem with Style Scheduling when using Style Masking in databases upgraded from AutoTrack v2

v3.0.0

New features since AutoTrack V2:

New look 'Options' area in the Settings window with many new options to configure the way that the User interface works - such as a new option that allows you remove the warning message that is shown when saving a Song or Link card using a different number than it was originally displayed with.

New scheduling reports allow you to easily see how quickly songs and links are being scheduled to allow you to fine tune your scheduling.

New colours and overall look and feel throughout.

Jingles are now called Links.

Show Formats are now called Show Rules.

Running Orders are now called Clocks.

The AutoSchedule tab has been renamed to the Schedule tab.

Both the Deck Viewers and the Song and Link Search results lists have been re-drawn to show more usefull information, whilst lesser used information has been hidden

Faster scheduling due to caching reading of already scheduled items information, and unification of Song and Jingle Category management.

If you add a link that does not have a Cart Number, it is sent as a Text Item to Myriad Systems.

Song and Link Search Results windows now have a "tree" folder view at the left to narrow down the search results even further. This can be hidden by a button on the toolbar.

Simpler Song and Link Search results windows and deck viewers - these have had the columns reordered and several lesser used columns have been removed.

Songs and Links that are "forced" in clocks are now added to scheduling histories.

AutoTrack v3 cannot use version 2 databases, so options have been added to automatically import all of the information from them.

The Histories now store the exact time that the item is scheduled to play - this means tighter control over rotations as previously it was only accurate to 1 hour

New look statistics reports show you exactly how your songs and links are distributed throughout your database.

If you place a file called sidelogo.gif in the database's folder (is a subdirectory of the folder that contains your database and has same name as your database) then this is displayed instead of the AutoTrack Logo at the side of the dialog windows. Ideally this should be 55x187 pixels

New features for AutoTrack Pro users:

User Management allows you to secure your AutoTrack system, and therefore only allow authenticated users to use the facilities. You can also restrict certain users from certain functions.

Links can now have Types as well as Categories. This means there are also new tabs on Station Rules and Show Formats.

Hour restrictions grids on Songs, Links and the week mask on the Schedule screen can now be loaded and saved from Hotlists.

You can now assign Songs to Song Collections, and Link to Link Collections. A Collection can be considered to be a deck within a deck - akin to paper-clipping several Song/Link 'Cards' together. Each time the collection comes to the front of the deck during scheduling, the front card is checked to see if it can be scheduled. If it can, then it is moved to the back of the collection, and then the collection is moved to the back of the deck. If it can't, the scheduler steps over the collection and checks the next song/link as normal. You can set Collections so that the scheduler checks each and every item in the collection in turn whenever the collection comes up for scheduling until it finds one that can be used, or it has checked each card. For a fuller description, please see the documentation.

You can now see a "history" by song or link category - this tells you how many times and how regularly each category is used per hour. The "All" option is usefull to check that your categories are being optimally used.

You can edit the scheduled log before it is sent to your playout system, including the ability to drag'n'drop entries from almost any window.

You can now send to many different types of playout systems - you can even send to several different systems from the same database simultaneously - for instance, you may run Myriad at your site so you need schedule information sent to it correctly, but your breakfast show comes from a remote studio who have a different playout system installed - AutoTrack can easily generate logs for both at the same time.

Assign colours to Song and Link Categories and Types to easily identify key information throughout AutoTrack.

"Mass Changers" for both Song and Link results lists allow you to quickly change multiple information on every selected cards in one go.

A new "Suggest A Song" option on the Tools menu allows you to easily pick a single song from a selection of Categories, or have several matching songs added to a pad. Useful for getting a quick list of suitable songs to play in an emergency.

You can easily copy part or all of a database to another database using a new Copy window on the Tools menu. You can also "send" individual song/link cards or groups of songs or links to another database using a new option on the Tool menu of the Song/Link Search results window.

